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Note:  This document  assumes that  user is  executing commands on Linux 
operating system in bash shell

Install HiFUN using installation package provided by us.

Install HiFUN

At the end of successful  HiFUN installation, installation screen will  provide list of  environment  
variables to be set in user's .bashrc file. These environment variables are necessary for HiFUN 
execution.

The environment variables that need to be defined in .bashrc file as follows:

source <<installation path of package>>/hifunrc

File 'hifunrc' will be having following Environment Variables, necessary for HiFUN execution.

HiFUN=<installation path of package>

PATH=$HiFUN:$PATH

export HiFUN PATH 

OPENMPI=${HiFUN}/Third_Party

PATH=$OPENMPI/openmpi-1.3.3/bin:$PATH

export OPAL_PREFIX=$OPENMPI/openmpi-1.3.3

export LD_LIBRARY_PATH=$OPENMPI/gfortran:$LD_LIBRARY_PATH

export LD_LIBRARY_PATH=$OPENMPI/openmpi-1.3.3/lib:$LD_LIBRARY_PATH
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Install Chitragupta

At the end of successful Chitragupta License Manager  installation, installation screen will provide 
list  of  environment variables to be set in user's .bashrc file.  These environment variables are  
necessary for to use Chitragupta License Manager.

The environment variables that need to be defined in .bashrc file as follows:

if [ -f <<installation path of package>>/chitraguptarc ]

then

   source <<installation path of package>>/chitraguptarc

fi

File 'chitraguptarc' will be having following Environment Variables, required for license manager 
usage.

CHITRAGUPTA=<installation path of package>

PATH=$CHITRAGUPTA:$PATH

export CHITRAGUPTA PATH 
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License Manager: CHITRAGUPTA

“Chitragupta” is a floating (or network) license manager. User will be able to install the license 
manager using installer script provided by us.

How to use license manager in GUI mode?

 To start application, run command ‘chitragupta’ from command prompt.

Main application window:

Generate Hostid:

 Click 'Generate Hostid' button to generate host id of system for issuing license file (refer 
above figure). This will also create file 'hostid.hifun' in current directory containing host id of 
system.

 To generate license file,  please send us file  'hostid.hifun'  along with  IP address of  the 
machine.

 Once user receives license file from us, proceed to install license file.

Installing License:

To configure license manager, set following parameters (refer figure below):

 License File (Complete path to license file sent by us)
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 Once license file path is set, click on “Install” (refer above figure)

 This will install license file to License manager directory & hifun-3.1.1/License directory.

 If License file get installed properly, following message window will pop up.

 If HiFUN is not installed on users system, application will pop up with license installation 
error (refer figure below)



Copyright ©2014 S & I Engineering Solutions Pvt. Ltd. All rights reserved.



 
S & I Engineering Solutions Pvt. Ltd.

 If  license file is not installed, application will  not be able to start license manager (refer 
image below)

Starting License Manager:

 To start license manager, click on button “Start License Manager”  (refer figures above & 
below)
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Checking Status:

 To check license manager status, Click on button “Status” (refer to figure below)

Note: The current status of  license manager can be checked by clicking on the button 
“Status”

Stopping License Manager:

 To stop license manager, click the button “Stop License Manager”

Closing the window:

 To close the window, click the button “Close”

 Even after closing the window, license manager will run in background.

 User  can  restart  the  application  by  issuing  command  “chitragupta”.  On  start  up,  the 
application  will check whether or not license manager is running in background.

 In the event of license manager running in background, application will open status window 
displaying the current  status of license manager.
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Command Line Usage of License Manager:

LICENSE MANAGER INSTALLATION STEPS

• Untar and uncompress file Chitragupta.tar.gz

Command: tar -xjvf Chitragupta.tar.gz

• Goto directory Chitragupta

• Command: cd Chitragupta

• Untar and uncompress packages openssl-lib64.tar.bz2 and python-2.6.6-install.tar.gz, 
chitragupta.tar.gz

Command: tar -xvf chitragupta.tar.gz

Command: tar -xvf  openssl-lib64.tar.bz2

Command: tar -xvf  python-2.6.6-install.tar.gz

• Open file 'licmanrc' in directory 'Chitragupta' directory and set the variable 'INITAIL_PATH' 
to absolute path of the directory 'Chitragupta'

• Copy license file 'license.key' given by SandI to directory 'chitragupta'

Chitragupta Installation Directory => <initial_path>/Chitragupta/chitragupta

Contents of directory 'chitragupta'

 chitragupta.dat: The database file

 chitragupta.log:  Log file for registering messages

 pychitragupta.py: Python script to start the license manager

 pystopserver.py: Python script to stop the license manager

 pyhostid.py: Python script to get the host information of system

STEPS TO OBTAIN HOSTID

 Goto directory 'Chitragupta'

cd <initial_path>/Chitragupta

 Source the file 'licmanrc' in directory 'Chitragupta'

Command: source licmanrc

 Goto directory 'chitragupta'

cd chitragupta

 Execute following command to obtain hostid

           Command: python pyhostid.py
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 Send the output of above command along with IP address of the machine to facilitate 
generation of license file

STEPS TO START LICENSE MANAGER

 Goto directory 'Chitragupta'

           cd <initial_path>/Chitragupta

 Source the file 'licmanrc' in directory 'Chitragupta'

Command: source licmanrc

 Goto directory 'chitragupta'

cd chitragupta

 Execute following command to start license manager in background

Command: python pychitragupta.py ./license.key > ./out 2>&1 &

 For possible errors, check the file 'out' in directory chitragupta:

Command: tail -f out

 To check the process ID of license manager's python script:

Command: ps -u <account_name> | grep python

Note: Above command may show more than one python scripts depending on whether or 
not other applications are employing python.

MONITORING LICENSE MANAGER

Goto directory <initial_path>/Chitragupta/chitragupta

 tail -f chitragupta.log:  Command to monitor last few lines of file 'chitragupta.log' for license 
usage

 tail -f out: Command to monitor last few lines of file 'out' for possible license manager 
failures

 ps -u <account_name> | grep python: Command to check whether or not license manager 
is executing in background.

STEPS TO STOP LICENSE MANAGER:

 Goto directory <initial_path>/Chitragupta and source file 'licmanrc'

           Command: source licmanrc

 Goto directory chitragupta and execute following

           Command: python pystopserver.py ./license.key

 If python script running in background becomes defunct after execution of command in step 
1, it needs to be killed explicitly using following commands:
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(a) ps -u <account_name> | grep python => Gives the integer process ID <PID>
(b) kill -9 <PID>
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To start HiFUN application, run command ‘hifun’ from command prompt

Main application window:

Menubar:

The menu bar of  main application window has six menus with different sub-menus. The sub-
menus will be explained one-by-one in this documentation.

Welcome Screen:
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Tools Menu:

Tools menu is used to set global options specific to the main application.

Options:

Project Repository: Sets Project Repository path. This path will be used to store data pertaining 
to new projects.

Machine File for OPENMPI: To execute the flow solver through GUI in parallel using openmpi, 
machine file is required. Machine file has following format

<hostname1> slots=<number of cores>

<hostname2> slots=<number of cores>

.........

.........

.........

Flags for OPENMPI (optional): Machine specific flags to be passed on to OPENMPI.

Zip Format for New Project:  The storage space on hard drive pertaining to data required by 
application  during  project  execution  can  by  reduced  considerably  by  zipping  the  data.  The 
application supports three zipping formats, namely gzip/gunzip, bzip2/bunzip2 and xz. The default 
zip format is gzip. gzip format gives fast data input/output with reasonable data compression. The 
other formats provide higher data compression but at the cost of slow input/output. Hence gzip  
format is recommended over  other  two formats.  If  selected zipping format is not available on 
user’s system, default zip format (i.e. gzip) is used. Kindly note that only those zipping options that  
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are available on the system will be displayed here. If none of the zipping options are available on  
system, the application will  handle unzipped data.

License Process ID:  This is an integer ID of MPI process that will  communicate with license 
manager for checking out/in licenses. Its default value is 0.

Terminal Font Size:  Font size of text to be displayed on application's terminal window. In case 
user changes font size during a session, this change will come into effect for text to be displayed 
on terminal after the change has been made.

Select Application to open .pdf file: Select application to be used to open HiFUN documentation 
provided in PDF format.  Out of following PDF readers,this option will provide a list of PDF readers 
available on system:

 acroread

 evince

 okular

 kpdf

If none of above PDF readers are available, user has to separately use any other PDF reader to 
access HiFUN GUI documentation.
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File Menu:

File menu has following four sub-menus:

• New Project

• Open

• Close

• Quit

File->New Project

The sub-menu 'New Project'  is used to start a new project. After clicking on this sub-menu, 
application will pop up first page of project creation wizard window with different options as 
explained below:

Project creation wizard-- Choose Files:

This is the first page of project creation wizard having following three options: 

Project  Name: Name  of  the  project.  A  directory  with  this  name  will  be  created  in  Project 
Repository directory where all data pertaining to present project will be stored.

Select .msh file: Input mesh file in Fluent's .msh format. Supporting zip formats will depend on zip 
options available on system. 

Browse...: Button to select input .msh file by browsing through the directories on the hard disk 
(refer to figure below)
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Zip Output: Tick this option to write data in selected zip format (low storage space requirement),  
remove the tick to write data in ascii format (high storage space requirement). (refer figure above)

After  inputting  all  required  input  on  first  page,  click  button  'Forward'  to  continue.  With  this, 
application will parse input '.msh' file.

The button 'Back' (not active in the first wizard page) can be used to go back to previous wizard  
page.

Also, It is possible to cancel the wizard at any stage by clicking the button 'Cancel'.
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On second page, user should input the scale value to multiply the X, Y and Z coordinates of input 
mesh. After inputting scale, click forward to go to next page. (refer figure above)
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If Periodic zone information is available in .msh file, next page will display linking of periodic zones  
and their corresponding neighbour zones. All the periodic and neighbour zones will be assigned 
'Periodic'  boundary  condition  and  these  zones  will  not  be  displayed  subsequently  on  page 
corresponding to “Boundary Condition Assignment”.
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If input msh file contains 3D grid data and periodic zone is available in it, next page will display  
“Periodicity Option”  (refer figure above)

If input msh file contains 2D grid data, the next page will display an option to choose between 
coopering  or  rotating  2D grid.  (refer  figure  above).  The  option  cooper  should  be  chosen  for 
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carrying out  2D simulation while the option rotate should be chosen to carry out axisymmetric 
simulation.

Click button “Next” to assign Boundary Conditions.

On next page, user should assign boundary condition to all the surface zones available  in the 
.msh file. (refer figure above)

Different boundary conditions available are as follows:

 Farfield Reimann

 Internal

 Interior

 Interface

 Mass Flow Out

 Pressure Inlet

 Pressure Outlet

 Rotational Axis 

(Used for Rotational Periodicity with zero radius singularity. Available only for 2D grid  
with no periodic linking available and user has set option to rotate it.)

 Supersonic Inflow

 Supersonic Outflow
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 Symmetry

 Wall

To assign boundary option for a given zone, select  zone name from left  side list  followed by  
boundary option from right side list and then click on the button 'Apply'.

User can also select multiple zones names from left side list and assign same boundary option  
from right side list by using shift or ctrl keys.

After assigning boundary condition options to all zones, click the button 'Forward' to go to next 
page.

The next page pertains to assigning porous/rotating zone options to cell zones present in input  
mesh file. The user may select one or both options from right side list by selecting them one after  
another. (refer figure above)

After assigning appropriate options to cell zones, click the button 'Forward' to go to next page.
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If the input mesh contains non conformal block interfaces, wizard will navigate to next page.

On this page, user can select multiple options from both left and right side lists.

For the purpose of pairing, all the interfaces selected on right side list will be paired with each  
interface selected on left side list.

Pairing all the interfaces in left side list is mandatory. (refer figure above)

After pairing all the interfaces, click button 'Forward' to go to next page.
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This is the final page of preprocessing wizard to input number of subdomains for parallel run. User  
can  input  number  of  subdomains  at  this  stage  or  at  the  time  of  creation  of  new run  (to  be 
discussed later).

After clicking on button “Finish” (refer  above figure),  preprocessing of mesh file will  begin. All  
output/errors will  be displayed on application's  inbuilt  terminal.  The different  steps involved in 
preprocessing are as follows:
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 Fluent's “.msh” reader: This step converts the input mesh file from fluent's .msh format to HiFUN's  
.geo format.

2D to 3D Converter: This step converts 2D grid data to 3D grid data.
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Geometric computations: This step computes geometric parameters required for the flow solver.

Nodal connectivity computations: This step computes connectivity required by the flow solver.

Minimum distance computation: This step computes minimum distance required for turbulent 
computations.
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Cell connectivity computation: This step computes cell based connectivity required to construct 
graph.
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Graph computation: This step computes the graph required for domain decomposition.

After aforementioned step, first phase of preprocessing is over and a project ('New_Project14' in 
present case) will be created. The preprocessed grid data up till  this stage may be stored and 
current project can be closed using File->Close . The application can be exited using File->Quit. 
Note: Application window can not be closed unless user closes current project.

This project can be reopened using menu File->Open. (refer figure above)
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Run Menu:

Run menu is used to create a new run. A given project should have at least one run for solver to  
be executed. Each run has a unique name and associated number of subdomains.

To create a new run, select 

Run->New Run

Application will pop up a window to input run name and  number of subdomains.

Once user inputs this information and clicks button 'OK', application will  execute following two 
steps to prepare data for parallel run. (refer figure above)

MeTIS execution: This is a third party software used for domain decomposition. (refer figure below
)
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FEP execution: The Front End Program (FEP) decomposes preprocessed grid  in as many parts 
as the number of subdomains. (refer figure below)
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At the end of FEP execution, solver input dialog window for this run will pop out. 

 In this dialog, user has to set values to different parameters required for executing the flow 
solver. These parameters are explained below:
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(1) Flow Solver

Parameter Option Comment

Flowtype

External 
Side-Slip

For external flow computations with given angle of attack 
and side slip angle

Internal For internal flow computations

External 
Roll

For external flow computations with given angle of attack 
and roll angle about longitudinal axis of configuration 

Nature of Flow
Inviscid For inviscid flow simulations

Viscous For viscous flow (Laminar or turbulent) simulations

Turbulence 
model

None

This option is visible only if Nature of Flow is set to 
Viscous.

Spalart 
Allmaras

K-OMEGA 
SST

K-OMEGA 
TNT

Compressibility 
correction

Tick / 
untick

This option is visible if Turbulence model is set to Spalart 
Allmaras. Tick this option if the geometry has large base.
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(2) Solution convergence

Parameter Option    Comments

Initialization Option Free stream 

Init-Restart

Restart

Special Restart

Maximum number of 
iterations

<integer number>

Minimum residue for 
convergence

<float number>
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(3) Spatial discretization

Parameter Option Comment

Scheme for inviscid 
Flux Calculation

Various

Viscous Flux 
Calculation

Green 
Gauss

Spatial Accuracy

First 
Order
Second 
Order

Gradient
Primitive 
reconstru
ction

This option is visible only if Spatial Accuracy is set 
to 'Second Order'

Use Limiter
Tick / 
untick

This option is visible only if Spatial Accuracy is set 
to 'Second Order'

Limit control parameter
Float 
value

This option is visible only if Spatial Accuracy is set 
to 'Second Order'

Use robustness fix Tick / 
untick

Switches on/off robustness fix for stiff problems
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Parameter Option Comment

Robustness Fix Option Basic

Advanced

Number of robustness 
fix layers

Various

Read cell flags for 
robustness fix

Tick / 
untick
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(4) Temporal discretization

Parameter Option Comment

Time integration 
procedure

Implicit Implicit scheme employs Symmetric Gauss 
Seidel (SGS) matrix free relaxation procedure

Explicit
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Parameter Option Comment

Time step Global

Local

Number of sweeps
<integer 
number>

Required for implicit time integration, typically 
10

Under-relaxation 
parameter

<Float number> 
<= 1.0

Used for SGS procedure

Implicit boundary 
option

Tick / untick Tick to switch on implicit boundary treatment 
during implicit time integration.

Multiplication factor 
for automatic CFL 
ramping

<Button> Used in implicit procedure, CFL = iteration times 
CFL multiplying factor.

Click 'Set' button to add automatic CFL ramping 
options. (refer to figure above)

Freeze CFL Tick / untick Tick to freeze CFL number

Maximum 
permitted CFL

<Float number> Upper limit for CFL number
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(5) Free stream conditions

(Nature of Flow == Inviscid)

(Nature of Flow == Viscous and Turbulence Model == Spalart Allamaras)
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(Nature of Flow == Viscous and Turbulence Model == K-OMEGA SST/TNT)

Parameter Option Comment

Stream wise Direction
Character 
value : x / y / z

Normal Direction
Character 
value : x / y / z

Cross flow Direction
Character 
value : x / y / z

Free stream Mach Number <Float value>

Angle of attack in degrees <Float value>

Side-slip angle in degrees <Float value>

Free stream Pressure in 
Pascals

<Float value>

Free stream Temperature 
in Kelvins

<Float value>

Free stream Dynamic <Float value>
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Parameter Option Comment

viscosity

Free stream Thermal 
Conductivity

<Float value>

Ratio of Modified Turbulent 
Viscosity 

<Float value>
Ratio of free stream modified turbulent 
viscosity to free stream kinematic viscosity 

Free stream Turbulent 
Kinetic Energy

<Float value>

Free stream Turbulent 
Kinetic Energy Dissipation 
Rate

<Float value>
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(6) Reference values

Parameter Option Comment

Characteristics Area in 
square meters

<Float value>

Reference Moment Arm <Float value>

X-coordinate of Moment 
Reference Point

<Float value>

Y-coordinate of Moment 
Reference Point

<Float value>

Z-coordinate of Moment 
Reference Point

<Float value>

Reference Pressure In 
Pascal

<Float value>
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(7) Parallel file read

Parameter Option Comment

Run option
Parallel Read

Use option 'Parallel Read' by default
Serial Read
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(8) Set halt option

Parameter Option Comment

Halt Program Tick / untick Tick this option to halt the solver run
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The boundary zones like Wall, Pressure Inlet and Pressure Outlet, Periodic as well as fluid zones 
require advanced parameters described below:

Wall Boundary Condition
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Parameter Option Comment

Wall Velocity Type
Translational 
Wall
Rotational 
Wall

U Velocity
<Float 
value>

Set x component of velocity for translational wall 
boundary

V Velocity
<Float 
value>

Set y component of velocity for translational wall 
boundary

W Velocity
<Float 
value>

Set z component of velocity for translational wall 
boundary

Start point: X 
coordinate

<Float 
value>

X coordinate of starting point for axis of rotation 
in case of rotational wall boundary

Start point: Y 
coordinate

<Float 
value>

Y coordinate of starting point for axis of rotation 
in case of rotational wall boundary

Start point: Z 
coordinate

<Float 
value>

Z coordinate of starting point for axis of rotation 
in case of rotational wall boundary

End point: X 
coordinate

<Float 
value>

X coordinate of ending point for axis of rotation in 
case of rotational wall boundary

End point: Y 
coordinate

<Float 
value>

Y coordinate of ending point for axis of rotation in 
case of rotational wall boundary

End point: Z 
coordinate

<Float 
value>

Z coordinate of ending point for axis of rotation in 
case of rotational wall boundary

Rotational Speed
<Float 
value>

Specify rotational speed in case of rotational wall 
boundary

Wall Temperature
Adiabatic 
Wall
Isothermal 
Wall

Isothermal wall 
temperature

<Float 
Value>

Specify constant wall temperature for isothermal 
wall boundary

Include this wall's 
contribution to global 
coefficient

Tick / untick
Tick this option if the contribution of computed 
force and moment coefficients is to be included in 
global coefficients computation.
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Fluid

Parameter Option Comment

Porous Zone Tick / untick Tick for specifying porous cell zone

Viscous Resistance Matrix
3 X 3 Matrix of 
floats

Inertia Resistance Matrix
3 X 3 Matrix of 
floats

Rotational Zone Tick / untick
Tick to specify rotational zone to be 
treated using Rotating Frame of 
Reference Algorithm

Start point: X coordinate <Float value>
X coordinate of starting point for axis 
of rotation for cell zone

Start point: Y coordinate <Float value>
Y coordinate of starting point for axis 
of rotation for cell zone

Start point: Z coordinate <Float value>
Z coordinate of starting point for axis 
of rotation for cell zone
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Parameter Option Comment

End point: X coordinate <Float value>
X coordinate of ending point for axis of 
rotation for cell zone

End point: Y coordinate <Float value>
Y coordinate of ending point for axis of 
rotation for cell zone

End point: Z coordinate <Float value>
Z coordinate of ending point for axis of 
rotation for cell zone

Rotational Speed <Float value> Specify rotational speed for cell zone
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Periodic Boundary Condition

No additional parameters are required, if user selects Translational Periodicity while creating 
project.
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If user selects Rotational Periodicity while creating project.

Parameter Option Comment

Rotate Axis X / Y / Z

Rotate Angle <Float value>
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Pressure Inlet Boundary Condition

Parameter Option Comment

Inlet Mach Number <Float value>

Total Pressure <Float value>

Total Temperature <Float value>

Direction
Specify Direction

Normal to the 
boundary

Direction's X Component <Float value> In case 'Specify Direction' option is used

Direction's Y Component <Float value> In case 'Specify Direction' option is used

Direction's Z Component <Float value> In case 'Specify Direction' option is used
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Pressure Outlet Boundary Condition

Parameter Option Comment

Exit Pressure <Float value>
Back pressure to be used in case flow is subsonic 
at the boundary
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Mass Flow Outlet Boundary Condition

Parameter Option Comment

Mass Flow Rate 
(kg/s)

<Float value>
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For other Boundary Conditions requiring no additional parameters, following label will be 
displayed:
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Run->Edit Active Run:

User  can  edit  selected  (active)  run  by  selecting  'Run->Edit  Active  Run'  menu.  With  this,  
aforementioned window will be opened.

Once the user modifies or changes on any page, click button 'Apply' to save the changes.

User can set default values for selected page by clicking the button 'Default' .

User can save and close Edit Run dialog by clicking 'Save & Close'. It will save all parameters in a 
required format fro solver execution.
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Solver Menu:

Solver menu has one submenu i.e. Execute.

Solver->Execute:

User can execute solver through GUI by clicking the sub-menu 'Execute'.
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Postprocess:

The menu Postprocess have a sub-menus 'Postprocess Data' and 'Show Wall Coefficients'

Postprocess->Postprocess Data:

By clicking the sub-menu 'Postprocess Data', an option window pops up. In this window, there are 
two options with the help of which user can write the volume data or wall surface data.

Option->Wall Surface Mesh:
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If user selects the option 'Wall Surface Data', the surface grid and the associated solution data is 
output in the tecplot-ascii format. The output file is stored in the following directory : <RUN 
directory>/Posprocess/Surface_Data
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Option->Volume Mesh:

If user selects the option 'Volume Mesh', the solution files pertaining to all the subdomains are 
combined together into a single solution file pertaining to entire computational domain.
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If combined solution file is already available, application will ask if user wants to replace this file or 
not.

There are three different output formats available for writing the volume data

 Tecplot Format 

 CGNS Format

 VTK Format

In case the solution files are not available in the run directory, only the grid data is written. 
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Postprocess->Show Wall Coefficients:

By clicking the sub-menu 'Show Wall Coefficients', an option window pops up. In this window, on 
left side, a list of all zone names having Wall boundary condition option will be displayed.

By clicking on each item in the left hand side list, user can get the values of coefficients for that 
particular  zone.
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On Right Click, there are option menus to convert selected Wall Coefficient values from Body Axis 
to Wind Axis and from Body Axis to Stability Axis. User can save these values in a file for future  
reference.

Body Axis to Wind Axis

Body Axis to Stability Axis
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Plot:

This utility provides 2D plots. It has following submeus:

 Convergence Histories

 Force Coefficients Evolution

 Moment Coefficients Evolution

 Mass Flow Rate Evolution
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Plot->Convergence Histories:

Convergence Histories have following options for plotting

Plot will be displayed as follows:
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Plot->Force Coefficients Evolution:

Force Coefficients Evolution have following options for plotting

Plot will be displayed as follows:
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Plot->Moment Coefficients Evolution:

Moment Coefficients Evolution have following options for plotting

Plot will be displayed as follows:
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Plot->Mass Flow Rate Evolution:

Mass Flow Rate Evolution will  give plot  option for  all  available  zones having Pressure Outlet 
boundary condition

Plot will be displayed as follows:
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On Y axis, the valuse may be plotted on linear or log scale. 

For refreshing the plot, click button 'Refresh'.
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Help:

This menu has following submenus:

• Documentation

• About 

• Disclaimer

Help->Documentation

It displays HiFUN's documentation in PDF format.

Help->About

This will display HiFUN Version and Developer Details.
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Help->Disclaimer

This is HiFUN Disclaimer.
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Utilities:

HiFUN GUI provides few utilities to display/manage project/run properties. 

For a Project, following utilities are available:

Rename

Zip/Unzip Project

View Preprocessing Log

Properties

For a Run, following utilities are available:

Edit

Copy

Remap

Rename

Delete

View Solution Log

View Postprocessing Log

Properties
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Project Utilities:

Rename:

This utility enables the user to change project name.

Zip/Unzip:

This utility enables the user to zip or unzip the project and the associated run data.

View Preprocessing Log:

This will display preprocessor log on terminal window.
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Project Properties: 

This utility displays properties of the project.

3D Project Properties

2D Project Properties
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Run Utilities

Edit: This utility pops up solver input dialog window.
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Copy: This utility can copy the entire run or only run properties to a New Run.

Remap:

This utility can be used to remap the grid and solution data with given number of subdomains to a  
new run having different number of subdomains.

Delete:

User can delete any run using this utility. If the subdomain dictionary linked to this run is not linked 
to any other run, application will also ask if user wants to delete subdomain data.
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Rename:

This utility can be used to change the name of a run.

View Solution Log:

This will display solution log on terminal window.
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View Postprocessing Log:

This will display post processing log in application terminal window.

Run Properties:

This will show properties of current selected run. Properties include Run name & Number of 
subdomains linked with that run.

Note: The utilities associated with a run can not be used if solver execution is under progress in 
that run directory.
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HiFUN

Batch Mode Execution
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HiFUN batch mode execution has following steps:

 parse

 preprocess

 solver

 postprocess

parse:

It will parse the input .msh file and extract required zone information. 

Write following options in 'hifunpre.dat' file

<project option : 0 -> New Project, 1 : Old Project> 

<Project Name or Project Directory Path>

<Absolute path to mesh file>

Command: 

hifun batch parse hifunpre.dat <argument>

argument: 

test

run

If argument is 'test', program will test the input file format and given values.

If argument is 'run', program will test the input file format and given values. It will run parser 
if file format & given values are correct. 

Any error found, program will display the error/s on terminal and will exit.

Output:

Output will get written in same input file.
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preprocess:

After successfully completing parsing, user have to open and edit input file / hifunpre.dat, and 
modify the required information for preprocessing. 

For e.g. User have to specify

 Scale to multiply

 Zip Option

 Periodicity Option in case of 2D grid data

 Boundary Condition for each Zone

 Cellzone information

 Interface Pairing Information

 Number of Subdomains

For  the  list  available  boundary  conditions  with  HiFUN,  user  can  refer  to 
“Available_boundary_conditions.txt”  in  current  working  directory  after  completing  parsing 
successfully.

Command:

hifun batch preprocess hifunpre.dat <argument>

argument: 

test

run

If argument is 'test', program will test the input file format and given values.

If  argument  is  'run',  program  will  test  the  input  file  format  and  given  values.  It  will  
preprocess data if given file format & given values are correct. 

Any error found, program will display the error/s on terminal and will exit.

Output:

All  the  files  /  data  generated from preprocessing  steps will  get  stored in  given project  
directory.

For any error, please refer to 'hifunerr.log' in project directory.

solver:
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Once the preprocessing of data got successfully completed, user have to open same project in  
HiFUN GUI and create required number of runs.

After creating runs, user have to  set the required parameter for each run and save the values.

After setting all the parameters, close the project.

To run solver in batch mode

Command:

hifun  batch  solver  <rundirprefix>  <runheader>  <runtype>  <smallest_run_number> 
<largest_run_number> <no_of_cores> <argument>

<rundirprefix> = Prefix path for run directories

<runheader> = Run header

<runtype> = general : General run

<runtype> = special : Special run

<smallest_run_number> = Smallest integer run number (usually 1)

<number_of_runs> = Total number of runs

<no_of_cores> = Number of processes/subdomains/cores to be used

<argument> = test : Tests input

<argument> = run : Tests input and executes the script

Note: <smallest_run_number> should be less than <largest_run_number> 
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postprocess:

Command:

        hifun batch postprocess <full path of project directory> <run name> <option> <output type> 
<argument>

Option:

     1) surface for Wall Surface Mesh

     2) volume for Volumn Mesh

     3) both for Wall Surface Mesh and Volumn Mesh

Output types:

    1) For Wall Surface Mesh

        * plt

    2) For Volumn Mesh

        * vtk

        * cgns

        * plt

Valid arguments:

     1) test

     2) run
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